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4 SUBMERGED CONSTRUCTION OF AN EXCAVATION (LESSON 2) This lesson illustrates the use of PLAXIS for the analysis of submerged construction at an excavation. Most of the program features that were used in Lesson 1 will be utilised here again. In addition, some new features will be used, such as the use of interfaces and anchor elements, the generation of water pressures and the use of 'staged construction' as a calculation facility. The new features will be described in full detail, whereas the features that were treated in Lesson 1 will be described in less detail. Therefore it is suggested that Lesson 1 should be completed before attempting this exercise. This lesson concerns the construction of an excavation close to a river. The excavation is carried out in order to construct a tunnel by the installation of prefabricated tunnel segments. The excavation is 30 m wide and the final depth is 20 m. It extends in longitudinal direction for a large distance, so that a plane strain model is applicable. The sides of the excavation are supported by 30 m long diaphragm walls, which are braced at the top by horizontal struts at an interval of 5.0 m. The upper 20 m of the subsoil consists of soft soil layers, which are modelled as a single homogeneous clay layer. Underneath this clay layer there is a stiffer sand layer which extends to a large depth.



Figure 4.1 Geometry model of the situation of a submerged excavation The bottom of the problem to be analysed is taken at 40 m below the ground surface. Since the geometry is symmetric, only one half (the left side) is considered in the analysis. The excavation process is simulated in two separate excavation stages. The diaphragm wall is modelled by means a beam, such as used for the footing in the previous lesson. The interaction between the wall and the soil is modelled at both sides by means of interfaces. The interfaces allow for the specification of a reduced wall friction compared to the friction in the soil. The strut is modelled as a spring element for which the normal stiffness is a required input parameter.
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For background information on these new objects, see the Reference Manual. 4.1 GEOMETRY To create the geometry model, follow these steps: General settings • • •



•



Start the Input program and select New project from the Create / Open project dialog box. In the Project tabsheet of the General settings window, enter an appropriate title and make sure that Model is set to Plane strain and that Elements is set to 6-node. In the Dimensions tabsheet, keep the default units (Length = m; Force = kN; Time = day) and enter for the horizontal dimensions (Left, Right) 0.0 and 45.0 respectively and for the vertical dimensions (Bottom, Top) 0.0 and 40.0. Keep the default values for the grid spacing (Spacing=1m; Number of intervals = 1). Click on the button after which the worksheet appears.



Geometry contour, layers and structures •



•



•



•
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The geometry contour: Select the Geometry line button from the toolbar (this should, in fact, already be selected for a new project). Move the cursor to the origin (0.0; 0.0) and click the left mouse button. Move 45 m to the right (45.0; 0.0) and click again. Move 40 m up (45.0; 40.0) and click again. Move 45 m to the left (0.0; 40.0) and click again. Finally, move back to the origin and click again. A cluster is now detected. Click the right mouse button to stop drawing. The separation between the two layers: The Geometry line button is still selected. Move the cursor to position (0.0; 20.0). Click on the existing vertical line. A new point (4) is now introduced. Move 45 m to the right (45.0; 20.0) and click in the other existing vertical line. Another point (5) is introduced and now two clusters are detected. The diaphragm wall: Select the Beam button from the toolbar. Move the cursor to position (30.0; 40.0) at the upper horizontal line and click. Move 30 m down (30.0; 10.0) and click. In addition to the point at the toe of the wall, another point is introduced at the intersection with the middle horizontal line (layer separation). Click the right mouse button to finish the drawing. The separation of excavation stages: Select the Geometry line button again. Move the cursor to position (30.0; 30.0) at the wall and click. Move 15 m to the right (45.0; 30.0) and click again. Click the right mouse button to finish drawing.
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Hints:



>



>



>



•



•



Hints: >



Within the geometry input mode it is not strictly necessary to select the buttons in the toolbar in the order that they appear from left to right. In this case, it is more convenient to create the wall first and then enter the separation of the excavation stages by means of a Geometry line. When creating a point very close to a line, the point is usually snapped onto the line, because the mesh generator cannot handle non-coincident points and lines at a very small distance. This procedure also simplifies the input of points that are intended to lie exactly on an existing line. If the pointer is substantially mis-positioned and instead of snapping onto an existing point or line a new isolated point is created, this point may be dragged (and snapped) onto the existing point or line by using the Selection button. In general, only one point can exist at a certain coordinate and only one line can exist between two points. Coinciding points or lines will automatically be reduced to single points or lines. The procedure to drag points onto existing points may be used to eliminate redundant points (and lines). The interfaces: Click on the Interface button on the toolbar or select the Interface option from the Geometry menu. The shape of the cursor will change into a cross with an arrow in each quadrant. The arrows indicate the side at which the interface will be generated when the cursor is moved in a certain direction. Move the cursor (the centre of the cross defines the cursor position) to the top of the wall (30.0; 40.0) and click the left mouse button. Move to the bottom of the wall (30.0; 10.0) and click again. According to the position of the 'down' arrow at the cursor, an interface is generated at the left hand side of the wall. Similarly, the 'up' arrow is positioned at the right side of the cursor, so when moving up to the top of the wall and clicking again, an interface is generated at the right hand side of the wall. Click the right mouse button to finish drawing. Interfaces are indicated as dotted lines along a geometry line. In order to identify interfaces at either side of a geometry line, a positive sign (⊕) or negative sign (θ) is added. The selection of an interface is done by selecting the corresponding geometry line and subsequently selecting the corresponding interface (positive or negative) from the Select dialog box.
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•



Hints:



>



The strut: Click on the Fixed-end anchor button on the toolbar or select the Fixed-end anchor option from the Geometry menu. Move the cursor to point 6 at position (30.0; 40.0) and click the left mouse button. A properties window appears in which the orientation angle and the equivalent length of the anchor can be entered. Enter an Equivalent length of 15 m (half the width of the excavation) and click on the button (the orientation angle remains 0°). A fixed-end anchor is represented by a rotated T with a fixed size. This object is actually a spring one end of which is connected to the mesh and the other end is fixed. The orientation angle and the equivalent length of the anchor must be directly entered in the properties window. The equivalent length is the distance between the connection point and the position in the direction of the anchor rod where the displacement is zero. By default, the equivalent length is 1.0 unit and the angle is zero degrees (i.e. the anchor points in the positive x-direction). The selection of an existing fixed-end anchor is done by clicking on the 'middle bar' of the corresponding T.



Figure 4.2 Geometry model in the Input window
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Boundary Conditions To create the boundary conditions, click on the Standard fixities button on the toolbar. As a result, the program will generate full fixities at the bottom and vertical rollers at the vertical sides. These boundary conditions are in this case appropriate to model the conditions of symmetry at the right hand boundary (center line of the excavation). This exercise does not involve line forces or traction loads. The geometry model so far is shown in Fig. 4.2. Material properties After the input of boundary conditions, the material properties of the soil clusters and other geometry objects are entered in data sets. Interface properties are included in the data sets for soil (Data sets for Soil & interfaces). Two data sets need to be created; one for the clay layer and one for the sand layer. In addition, a data set of the Beam type is created for the diaphragm wall and a data set of the Anchor type is created for the strut. To create the material data sets, follow these steps: • •



•



Click on the Material sets button on the toolbar. Select Soil & interfaces as the Set type. Click on the button to create a new data set. For the clay layer, enter 'Clay' for the Identification and select Mohr-Coulomb as the Material model. Since only long-term effects of the excavation are considered here, we will not take into account the undrained behaviour. Hence, the material type is set to Drained. Enter the properties of the clay layer, as listed Table 4.1, in the corresponding edit boxes of the General and Parameters tabsheet. Click on the Interfaces tab. In the Strength box, select the Manual radio button. Enter a value of 0.5 for the parameter Rinter . This parameter relates the strength of the soil to the strength in the interfaces, according to the equations: tanϕinterface = Rinter tanϕsoil and cinter = Rinter csoil Here:



csoil = cref (see Table 4.1)



Hence, using the entered Rinter -value gives a reduced interface friction and adhesion compared to the friction angle and the cohesion in the adjacent soil. In the Permeability box, select the Impermeable radio button. By imposing this condition, any interface that has this data set gets a very low permeability (compared to the permeability of the soil) across the interface. This is done to make the adjacent wall watertight. A wall modelled as a beam does not have a parameter to make it impermeable by itself. Click on the button to close the data set.
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Table 4.1. Material properties of the sand and clay layer and the interfaces Parameter



Name



Clay layer



Sand layer



Unit



Material model Type of material behaviour Dry soil weight Wet soil weight Permeability in hor. direction Permeability in ver. direction Young's modulus (constant) Poisson's ratio Cohesion (constant) Friction angle Dilatancy angle Strength reduction factor inter. Interface permeability



Model Type γdry γwet kx ky Eref ν cref ϕ ψ Rinter Perm



Mohr-Coul. Drained 16 18 0.001 0.001 10000 0.35 5.0 25 0.0 0.5 Imperm.



Mohr-Coul. Drained 17 20 1.0 1.0 40000 0.3 1.0 32 2.0 0.67 Imperm.



kN/m3 kN/m3 m/day m/day kN/m2 kN/m2 ° ° -



Hints:



>



• • •
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The radio button Rigid in the Strength box is a direct option for an interface with the same strength properties as the soil (Rinter = 1.0). Similarly, the radio button Smooth is a direct option for an interface without any shear strength. The radio button Drain in the Permeability box is meant for situations in which interfaces act like drains (for example to speed up the consolidation process). As a result, the permeability in the longitudinal direction of the interface becomes very high compared to the permeability of the soil. The radio button Neutral is used in the cases where the interfaces is not meant as Impermeable (to 'block' the flow in perpendicular direction) nor as Drain (to ease the flow in longitudinal direction). The permeability parameters (for interfaces as well as for soil) are only of importance for consolidation and groundwater flow analyses. They are entered here purely for demonstration purposes.



For the sand layer, enter 'Sand' for the Identification and select Mohr-Coulomb as the Material model. The material type should be set to Drained. Enter the properties of the sand layer, as listed Table 4.1, in the corresponding edit boxes of the General and Parameters tabsheet. Click on the Interfaces tab. In the Strength box, select the Manual radio button. Enter a value of 0.67 for the parameter Rinter . In the Permeability box, select the Impermeable radio button. Close the data set.
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•



Drag the 'Sand' data set to the lower cluster of the geometry and drop it there. Assign the 'Clay' data set to the remaining three clusters (in the upper 20 m). By default, interfaces are automatically assigned the data set of the adjacent cluster.



Hints:



Instead of accepting the default data sets of interfaces, data sets can directly be assigned to interfaces in their properties window. This window appears after double clicking the corresponding geometry line and selecting the appropriate interface from the Select dialog box. On clicking the button behind the Material set parameter, the proper data set can be selected from the Material sets tree view. In addition to the Material set parameter in the properties window, the Virtual thickness factor can be entered. This is a purely numerical value which can be used to optimise the numerical performance of the interface. Non-experienced users are advised not to change the default value. For more information about interface properties see the Reference Manual.



>



• •



Set the Set type parameter in the Material sets window to Beams and click on the button. Enter “Diaphragm wall” as an Identification of the data set and enter the properties as given in Table 4.2. Click on the button to close the data set. Drag the Diaphragm wall data set to the wall in the geometry and drop it as soon as the cursor indicates that dropping is possible.



Table 4.2. Material properties of the diaphragm wall (beam)



• •



Parameter



Name



Value



Unit



Type of behaviour Normal stiffness Flexural rigidity Equivalent thickness Weight Poisson's ratio



Material type EA EI d w ν



Elastic 7.5⋅106 1.0⋅106 1.265 10.0 0.0



KN/m kNm2/m m kN/m/m -



Set the Set type parameter in the Material sets window to Anchors and click on the button. Enter “Strut” as an Identification of the data set and enter the properties as given in Table 4.3. Click on the button to close the data set. Drag the Strut data set to the anchor in the geometry and drop it as soon as the cursor indicates that dropping is possible.
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Table 4.3. Material properties of the strut (anchor) Parameter



Name



Value



Unit



Type of behaviour Normal stiffness Spacing out of plane Maximum force



Material type EA Ls Fmax



Elastic 2⋅106 5.0 1⋅1015



KN m kN



Mesh Generation In this lesson some simple mesh refinement procedures are used. In addition to a direct global mesh refinement, there are simple possibilities for local refinement within a cluster, on a line or around a point. These options are available from the Mesh menu. In order to generate the proposed mesh, follow these steps: •



Click on the Generate mesh button in the toolbar. A few seconds later, a coarse mesh is presented in the Output window. Click on the button to return to the geometry input. From the Mesh menu, select the Global coarseness option. The Element distribution combo box is set to Coarse, which is the default setting. In order to refine the global coarseness, one could select the next item from the combo box (Medium) and click on the button. Alternatively, the Refine global option from the Mesh menu could be selected. As a result, a finer mesh is presented in the Output window. Click on the button to return. Corner points of structural elements may cause large displacement gradients. Hence, it is good to make those areas finer than other parts of the geometry. Click in the middle of the lowest part of the wall (single click). The selected geometry line is now indicated in red. From the Mesh menu, select the option Refine line. As a result, a local refinement of the indicated line is visible in the presented mesh. Click on the button to return.



•



•



Hints:



>
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The mesh settings are stored together with the rest of the input. On re-entering an existing project and not changing the geometry configuration and mesh settings, the same mesh can be regenerated by just clicking on the Generate mesh button on the toolbar. However, any slight change of the geometry will result in a different mesh. The Reset all option from the Mesh menu may be used to restore the default setting for the mesh generation (Global coarseness = Coarse and no local refinement).
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Figure 4.3 Finite element mesh of the excavation project Initial conditions The initial conditions of the current project requires the generation of water pressures, the deactivation of structures and the generation of initial stresses. Water pressures (pore pressures and water pressures on external boundaries) can be generated in two different ways: A direct generation based on the input of phreatic lines and groundwater heads or an indirect generation based on the results of a groundwater flow calculation. The current lesson only deals with the direct generation procedure. Generation based on groundwater flow is, presented in the second part of the Lesson 4 (see Section 6.2). Within the direct generation option there are several ways to prescribe the water conditions. The simplest way is to define a general phreatic line, under which the water pressure distribution is hydrostatic, based on the input of a unit water weight. The general phreatic line is used for the generation of external water pressures and this line is automatically assigned to all clusters for the generation of pore pressures. Instead of the general phreatic line, individual clusters may have a separate phreatic line or an interpolated pore pressure distribution. The latter advanced options will be demonstrated in the first part of Lesson 3 (see Section 5.2). Here only a general phreatic line is defined at 1.0 m below the ground surface. After the generation of water pressures and before the generation of initial effective stresses, parts of the geometry that are not active in the initial state must be deactivated. This option is used initially to deactivate geometry parts (clusters or structural objects) that are to be constructed at later calculation stages.
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In the current project, the diaphragm wall and the anchor are initially not present and should be deactivated for the initial geometry configuration. The K0-procedure for the generation of initial stresses will not take into account the deactivated geometry clusters. In order to generate the proper initial conditions, follow these steps: •



Click on the Initial conditions button on the toolbar. Hint:



•



When a project is input for the first time, the water weight is presented directly on entering the Groundwater mode. On re-entering an existing project the input of the water weight can be accessed by selecting the Water weight option from the Geometry menu in the Groundwater mode.



Click to accept the default value of the unit weight of water, which is 10 kN/m3. The Groundwater conditions mode then becomes active, in which the Phreatic line button is already selected. By default, a General phreatic line is generated at the bottom of the geometry. Move the cursor to position (0.0; 39.0) and click the left mouse button. Move 45 m to the right (45.0; 39.0) and click again. Click the right mouse button to finish drawing. The plot now indicates a new General phreatic line 1.0 m below the ground surface.



•



Hints:



• • • •
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An existing phreatic line may be modified by using the Selection button from the toolbar. On deleting the General phreatic line (selecting it and pressing the  key on the keyboard), the default general phreatic line will be created again at the bottom of the geometry. The graphical input or modification of phreatic lines does not affect the existing geometry.



Click on the Generate water pressures button (blue crosses) on the toolbar. Now the Water pressure generation window appears. From the Water pressure generation window, select the Phreatic line radio button in the Generate by box and click the button. After the generation of water pressures, the result is displayed in the Output window. Click on the button to return to the Groundwater conditions mode. Proceed to the Geometry configuration mode by clicking on the 'switch' in the toolbar.
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•



Click once on the wall and the strut in the geometry to deactivate them. Their colour should change into grey, indicating that these objects are deactivated. Make sure that all clusters remain active. Hint:



•



Inactive clusters are white, just like the background, whereas active clusters have the colour of the corresponding material set. Inactive structural objects are grey, whereas active structures have the basic colour as used during mesh creation.



Click on the Generate initial stresses button in the toolbar. The K0-procedure dialog box appears. Keep the total multiplier for soil weight equal to 1.0. Accept the default values for K0 and click on the button. After the generation of the initial effective stresses, the result is displayed in the Output window. Click on the button to return to the Initial configuration mode. Click on the button. Select in response to the question about saving the data and enter an appropriate file name.



• • •



4.2 CALCULATIONS In practice, the construction of an excavation is a process that can consist of several phases. First, the wall is installed to the desired depth. Then some excavation is carried out to create space to install an anchor or a strut. Then the soil is gradually removed to the final depth of the excavation. Special measures are usually taken to keep the water out of the excavation. Props may also be provided to support the retaining wall. In PLAXIS, these processes can be simulated by means of the Staged construction calculation option. Staged construction enables the activation or deactivation of weight, stiffness and strength of selected components of the finite element model. The current lesson explains the use of this powerful calculation option for the simulation of excavations. Hint:



The Staged construction option is not only intended to simulate excavations or constructions, but it can also be used to change the water pressure distribution, to change material properties (to simulate soil improvement, for example) or to improve the accuracy of previous computational results.
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Staged construction is only available within Plastic calculations of the Load advancement ultimate level type. The excavation, as considered in this example, is to be carried out in two phases. The separation of the two excavation phases was taken into account during the creation of the geometry model by introducing a geometry line in the appropriate position. In order to define the two calculation phases, follow these steps: • • •



Hint:



>



• • •
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In addition to the initial phase, the first calculation phase has already been automatically created by the program. In the General tabsheet, accept all defaults (Calculation type = Plastic, Load adv. ultimate level; Start from phase = 0 - Initial phase) In the Parameters tabsheet, keep the default value for the Control parameters and the Iterative procedure. Select Staged construction from the Loading input box. Click on the button. The Staged construction window now appears, showing the currently active part of the geometry, which is the full geometry except for the wall and the strut. Click on the wall and the anchor to activate them (the wall should become blue and the anchor should turn black). In addition, click on the cluster in the top right corner in order to deactivate it. As a result, the soil weight, stiffness and strength of the elements within that cluster will be removed from subsequent calculations. This simulates the first excavation phase. The Staged construction window is similar to the Initial conditions window of the Input program. The main difference between Initial conditions and Staged construction is that the former is used to create an initial situation, whereas the latter is used as a type of loading. When activating geometry objects, their stiffness and strength becomes active from the beginning of the calculation, whereas their weight is increased gradually. This is why the first excavation can be defined together with the activation of the wall and the strut.



Click on the button to finish the definition of the construction phase. As a result, the Staged construction window is closed and the Calculations window reappears. The first calculation phase has now been defined and saved. Within the Calculations window, click on the button. A new calculation phase appears in the list. In the General tabsheet, accept all defaults (Calculation type = Plastic, Load adv. ultimate level; Start from phase = 1 - ).
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• • •



Note that the program automatically presumes that the current state should start from the previous one. In the Parameters tabsheet, keep the default value for the Control parameters and the Iterative procedure. Select Staged construction from the Loading input box. Click on the button. The Staged construction window appears, showing the 'current' geometry configuration, in which the upper cluster at the right has already been deactivated. Click on the cluster just below to deactivate it (to simulate the second excavation stage) and click on the button.



Figure 4.4 The Calculations window with the Parameters tabsheet The calculation definition is now complete. Before starting the calculation it is suggested that you select nodes or stress points for a later generation of load-displacement curves or stress and strain diagrams. To do this follow the steps given below.
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• • •



Click on the Set points for curves button on the toolbar. Select some nodes on the wall at points where large deflections can be expected (e.g. 30.0;30.0) and click on the button. In the Calculations window, click on the Calculate button.



The calculation process should now start. The program searches for the first calculation phase that is selected for execution, which is . During a Staged construction calculation, a multiplier called ΣMstage is increased from 0.0 to 1.0. This parameter is displayed on the calculation info window. As soon as ΣMstage has reached the value 1.0, the construction stage is completed and the calculation phase is finished. If a Staged construction calculation finishes while ΣMstage is smaller than 1.0, the program will give a warning message. The most likely reason for not finishing a construction stage is that a failure mechanism has occurred, but there can be other causes as well. See the Reference Manual for more information about Staged construction. In this example, both calculation phases should successfully finish, which is indicated by the green check boxes in the list. In order to check the values of the ΣMstage multiplier, click on the Multipliers tab and select the Reached values radio button. The ΣMstage parameter is displayed at the bottom of the Other box that pops up. Verify that this value is equal to 1.0. You also might wish to do the same for the other calculation phase. 4.3 VIEWING OUTPUT RESULTS In addition to the displacements and the stresses in the soil, the Output program can be used to view the forces in structural objects. To examine the results of this project, follow these steps: • • • • •
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Click on the final calculation phase in the Calculations window. Click on the button on the toolbar. As a result, the Output program is started, showing the deformed mesh (scaled up) at the end of the selected calculation phase, with an indication of the maximum displacement ( Fig. 4.5). Select Total increments from the Deformations menu. The plot shows the displacement increments of all nodes as arrows. The length of the arrows indicate the relative magnitude. The presentation combo box in the toolbar currently reads Arrows. Select Shadings from this combo box. The plot should now show colour shadings of the displacement increments. From this plot a zone of intense shearing is visible behind the wall. Select Effective stresses from the Stresses menu. The plot shows the magnitude and direction of the principal effective stresses. The orientation of the principal
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stresses indicates a large passive zone under the bottom of the excavation and a small passive zone behind the strut (see Fig. 4.6).



Figure 4.5 Deformed mesh after excavation



Figure 4.6 Principal stresses after excavation To plot the shear forces and bending moments in the wall follow the steps given below. •



Double click on the wall. A new window is opened showing the bending moments in the wall, with an indication of the maximum moment (see Fig. 4.7). Note that the menu has changed.



4-15



PLAXIS



Figure 4.7 Bending moments in the wall •



Select Shear forces from the Forces menu. The plot now shows the shear forces in the wall. Hint:



• • • • •



4-16



The Window menu may be used to switch between the window with the forces in the wall and the stresses in the full geometry. This menu may also be used to Tile or Cascade the two windows, which is a common options in a Windows environment.



Select the first window (showing the effective stresses in the full geometry) from the Window menu. Double click on the strut. A new window is now opened showing the strut force in kN/m. Click on the Go to curves program button on the toolbar. As a result, the loaddisplacement curves program is started. Select New curve from the Create / Open curve dialog box and select the file name of the excavation project from the file requester. In the Curve generation window, select for the X-axis the Displacement radio button and point A (30.00/30.00) and from the Type combo box select the item |U|. Select for the Yaxis the Multiplier radio button and from the Type combo box ΣMstage. Click on the button to accept the input and generate the load-displacement curve. As a result the curve of Fig. 4.8 is plotted.
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Figure 4.8 Load-displacement curve of deflection of wall The curve shows the two construction stages. For each stage, the parameter ΣMstage changes from 0.0 to 1.0. The decreasing slope the curve of the second stage indicates that the amount of plastic deformation is increasing. The results of the calculation indicate, however, that the excavation remains stable at the end of construction.
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A small negative value for Ïˆ is only realistic for extremely loose sands. For further information about the link between the friction angle and dilatancy, see Bolton ...
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The properties of the concrete diaphragm wall are entered in a material set of the ... Table 6.1. Soil and interface properties. Parameter. Name. Fill. Sand. Loam.
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head in the sand layer follows the river water level variation closely. Figure 5.1 Geometry ... Material properties of the river embankment and subsoil. Parameter.
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Differences between Garlanger's and Buisman's forms are modest. The engineering strain Îµ is replaced by void ratio e and the consolidation time tc is replaced ...
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the effective Young's modulus, E', and the effective Poisson's ratio, Î½'. In the remaining .... in which Kw is the bulk modulus of the water and n is the soil porosity.
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